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1 Introduction

1.1 MDC Retaining Walls

Analysis of Gravity and reinforced concrete retaining walls either resting upon direct
foundations or borne on piles, and optionally restrained by tiebacks (anchors). The
program performs geotechnical calculations using th theories of Coulomb, Rankine &
Mononobe and Okabe (Coulomb in seismic conditions) and also performs verification
according to ruling standards among which global stability even in seismic conditions.
Structural computation sizes reinforcements both to Ultimate Limit State and to
Allowable Tension, and verifies reaction at different heights of the stem.
Beyond the strictly technical functions, the program provides facilities for: Saving and
recalling  project files, operational language  selection,  selection of
measurement units , Graphic default  set up, Graphic print preview , Text
Print Preview  and Edit, and Resource files  for common geotechnical constants.
For other Geostru Geothechnical Software products follow link below  or consult GeoStru
Software. 

1.1.1 Geostru Software

For a complete description and Technical datasheets of all Geostru Software and please
consult the GeoStru web site at www.geostru.com.

1.2 Computation model

Verification of the wall is done in the following sequence:

Phase I  
Terrain pressures and any surcharge on the stem are calculated. The stem is then
divided into a fixed number of segments that will hereafter be the verification segments.
For this phase, the thrust surface is taken to be the face of the stem. If Coulomb 's
method is selected the thrust is considered at an angle corresponding to the terrain wall
angle of friction declared in the geotechnic properties. If Rankine's method was selected
the thrust is considered to be horizontal. In phase I, the program determines stresses
only on the stem and performs structural verification using the materials specified by the
user and the selected criterion (Admissible Tension, or Limit State).

Phase II  
In this phase pressures calculations are repeated taking as thrust surface the vertical line
that passes through the uphill edge of the foundation heel. This time, with Coulomb’s
method, it is the angle of soil resistance that is used. Then all pressures (Overturning
and stabilizing moments) are determined in respect to the datum point that is the lower
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corner of the foundation toe. Thereafter the program performs Ultimate limit state,
Overturning, Sliding, and Limit load verifications.

Phase III 
In this phase the stresses on the footing shelves, segmented to a fixed number, are
determined. Then structural verification on the footing is performed.
If the footing is not anchored on piles, this completes the calculation.

Phase IV  
This phase is only relevant where pile further support the footing. Stresses transmitted
by the wall to the piles are consist in the moments obtained in phase II. The user may
chose to have transmitted to the piles the net resulting moment (difference between
overturning and stabilizing) or only the overturning one. Clearly this latter choice is only
reasonable where the overturning moment far exceeds the stabilizing. If more than one
line of piles is declared, the program performs verification calculation on the line that is
most stressed (normally by compression).

1.3 Measurment Units

The program is designed to allow the choice of either technical international
measurement units. Transfer from one set of units to the other is permitted at any time.
However the user might bear in mind that the conversion factors may involve decimal
approximations so that, in normal practice, it would be advisable to select one set and
hold it constant. 
The set used may be selected in the Preferences menu.

Standards for materials
Naming conventions for concrete resistance are adapted to whether S.I. (international)
or M.K.S. (technical)  measurement system is chosen. In either case the user is
requested to declare the typical cubic resistance in the following conventions.

M.K.S. Rck250 Rck300 Rck350

S.I. C-20 C-27 C-30

 

1.4 Program Installation

Package contents 
The package should contain a CD–ROM, the program’s usage license and optionally, the
hardware key. Manuals and help file can also be downloaded individually from our web
site.

Minimum configuration
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Windows 95/98/2000/XP/Vista or NT operating system.

A VGA screen with 16 Mb memory and 6 Mb free disc space.

For Optimum configuration, the following are recommended:
64 Mb memory and 100 Mb free disc space.
Colour Palette: 65536 colours.
Screen Resolution: 1024 × 768 pixels recommended, however not inferior to 800 x 600.
Small font size. 

Installation
Start computer and insert CD–ROM in drive (or if downloaded, the files will be present in
the download library).
No automatic loading occurs. Use Windows Explorer to view contents of the CD (or
download library).
Files with Zip extension should first be ‘unzipped’.
Installation requires the presence in your operating system of MS Installer program. 
This is included in Windows 2000, ME, XP operating systems.  For W95/98/NT, it must be
added as a one-time requirement.
For Windows 95/98 2click on instmsia.exe. For WindowsNT 2click on instmsiw.exe.
(check carefully)
This installs the MS Installer program in your operating system. 
(If you do not know whether MS Installer is present in your system, 2click the msi file as
indicated below. If the installer is present, installation will start. Otherwise Windows will
open the ‘Open with’ window indicating that it does not recognise this extension. If this
happens, Cancel and add the MS Installer as stated above).
To actually install the program(s), click on each file with extension msi.
The file name is an acronym of the program name (slope.msi etc.  Note that your
computer may be set up so as not to show extension acronyms, in which case the file
will show as slope alone.)
Follow instructions displayed during program installation.
If you have previously installed the same program, see below under Version Update.
Installation loads the program (exe), the help file (chm), and example/auxiliary files. The
manual, in zip, form must be loaded and expanded separately.
In the Start, Programs menu a ‘Geostru’ item is placed which expands to the programs
installed.

Hardware lock 
If you have purchased a hardware key you will need to install an additional item on the
CD (or download library).
Click on HDD32.exe to do this.

Software lock 
The use of this system requires the exchange of information (Email or Fax etc.) between
yourself and GeoStru Software S.a.S.. You will send Geostru the control number in the
Registration from the Help menu window when the program is run. GeoStru will respond
by sending you a registration number to enter in this opening window. This opens the full
functionality of the program. Until this is done the program operates in demonstration
mode.

Disintallation
This may be achieved in control panel (Start, Settings, Control panel).
Select Application Installation and chose remove against the program name.
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Version Update
When a version update is obtained, click on the msi extension as above but as a first
step, select remove. This removes the previous version. Then proceed as above (2click
msi file) to install the new one. With version update the previous registration number will
remain valid.
With some version updates, intentionally, this removal option is not presented and on
installing the new version the previous version remains. In the concrete case it will be
clear why this is.  In such cases a new registration number will be required.
Later when the older version is no longer required, it may be removed from the control
panel. See Disinstallation above.

1.5 Resource Files

Many GeoStru programs are distributed with .txt files which contain tables of data to
be used in the program, most typically to populate drop down selection lists. Among the
ones most widely used is the list of lithologic types and properties.
These files are distributed as a help to data entry and as it is envisaged that users may
have some more specific examples, they are available to the user for addition and
amendment. Typically the files are found within the program folder. (Ex:
\Programs\Geostru\Slope). Before undertaking any amendment it is advisable to save
the original file so that if any error occurs in the change, the situation may be restored.
Needless to say when applying changes to the files the original format and conventions
should be retained. These are not always evident when the file is opened in Notepad or
even Word Pad and therefore the following is suggested.
The method entails doing the actual editing in a Word table.
Open the file by clicking on it. Notepad starts and displays the file content. Select all the
file (SHFT+ CTRL+END). Copy the data. Open a new Word document (or other
equivalent text processor) Paste the file data into the document. Select all the data in
the document.
Convert to table after: 

1.  Identify the separator character (either tab or semicolon (;)) 

2.  Set this as the operative separator;

3.  Check ‘adapt to content’. 

When editing a Word document the graphics for space, tab, paragraph, page separator
and many others are hidden. It is useful in this case, and in the authors opinion always,
to show them.
The menu: Tools, Options, Display, check All  does this.
When the table is created amendments or additions can be applied with ease.
When all amendments have been applied and checked, reconvert the table to text (using
the same separator). Copy the text and paste back into the Notepad file text, replacing
the original, and save. The amended file is now operative.

Textures: Textures are also resource files distributed automatically with relevant
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programs but which may also be downloaded and installed in isolation. Textures are held
in a folder: “Retini” within the Geostru folder. Within the parent folder are four folders
for Cohesive, Cohesionless, Rocks, and Others. Within each of these folder are stored a
number of BMP files with the textures to display. The files are named with numbers i.e.
12.bmp, 43.bmp etc. These are the actual images used to ‘paint’ the object. The textual
description of the file is held in a text file named “bmp.txt”. However for international
versions this one text file is replaced by three: bmp_it.txt, bmp_es.txt, and bmp.en.txt
for Italian, Spanish and English texts. 
It is only necessary that the text files contain the names of the soils in the folder but for
simplicity all soils are present in each file. Editing of bmp.txt could be done as described
above.

1.6 Graphic Print Preview

When this command is invoked it opens the Print preview dialog window displaying a
print preview of the drawing in the worksheet set up to print at a scale such that it will fit
on the predefined page size. 
In the preview window are present a number of menu functions which affect the print
result without affecting the original in the worksheet. One of these invokes printing of
the image to the predefined printer.

The commands are:

Move: Pressing this button causes the mouse pointer to change to a hand and can be
used to ‘take’ (click) the drawing and move it (drag) elsewhere on the paper as seen in
the preview.

Scale +  e Scale - : Alters the scale of the drawing up or down in steps of 100:1. The
scale adopted is displayed in the plan scale frame. See also Plan Scale factor .

Plan Scale: Displays the scale at which the plan diagram will be printed. May be altered
as desired. Press enter to actuate the new scale.

Fit to page: Adjusts the scale of the image such as to fit on the defined page size
exactly. The scale adopted is displayed in the plan scale frame. (Selection of paper size
and orientation occurs in the Set Up printer in the File menu).

No. of Copies: Default is 1.

Print: Prints the preview image on the predefined printer (see Set Up printer in the
File  menu).

Exit
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1.7 RTF Editor

The program includes an internal text editor which enables text, such as reports, to be
produced edited and saved using RTF format.
RTF (Rich Text Format) is a document format that is compatible with all major text
processing programs. This format may be read by these text processors (Word, Word
Perfect etc.) and thereafter edited and saved in the text processor native format.
The editor may be invoked by requesting Print Report or from the toolbar. When
invoked the editor is opened and the program’ s data report is presented. Thereafter the
user may modify and/or enhance its aspect or contents at will, and/or save or print it. 
Basic text processing functions such as editing, tables, margins, tabs, and formatting are
available.
When the editor is closed, control returns to the original program. 

2 Menu

2.1 File Menu

The File menu contains those functions that enable the insertion, recall, printing and
closure of project files and their management.

New
Creates file(s) for a new project.(Function is also available from the Standard toolbar)

Open
Opens file(s) for a previously created project.  (Function is also available from the
Standard toolbar).

Save
Save file(s) for the currently open project, replacing any previous version. (Function is
also available from the Standard toolbar)

Save As
Save file(s) for the currently open project under the name and in the folder, to be
entered in a subsequent dialogue window. This creates a new file with that name. If the
file already exists the user is asked to confirm that it should be overwritten.

New Project Step by step
Step by step guide to project set up. Among choices offered are the normative standard
to be applied, which measurement units to be used, Type of wall (gravity, cantilever, pile
anchored etc), pile types, wall height. with these parameters a default wall is generated,
for user approval or amendment.

Import ‘Slope’ walls
Enables Stratigraphy and walls previously defined in the Geostru program ‘Slope’ to be
imported.
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Print Set-up
Presents standard Windows printer select & set up dialogue window.

Print Preview 
Presents preview of worksheet printed page(s) with dialog window for the control of the
printed image (scale, position etc.).

Recent Projects
Recalls the names of the last three open files.

Exit
Program exit.

2.2 Edit Menu

The Edit menu presents those functions relative to editing data for the currently open
project.

Copy
Copies to the clipboard the selected area of the active window. (Function is also available
from the Standard toolbar). This function is particularly useful to copy bitmaps of images
in the various phases of computation to a preferred editor (Word, Works etc.)

Paste
Copies to the current active window, the contents of the clipboard. This command
permits any raster image (e.g. slope sections read with a scanner) to be copied to the
current work sheet and then be used to define a new profile and/or layer by operating
with the mouse. 

Delete
Remove any bitmap inserted on the worksheet.

Copy 
may profitably be used to copy results including graphics from the worksheet for pasting
on the numeric report or as required.

2.3 View Menu

Redraw
Redraws the drawing correcting any defects due to editing process. (Normally caused by
editing of the contents)

Zoom All
A zoom factor is applied, such that the whole contents of the worksheet are displayed. 

Zoom Window
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Lets you draw a selection rectangle or "window" to view part of your display in the
drawing window. Use the left button to select one corner of the view you want. Now the
cursor becomes a stretching rectangle. Select a second corner for the view. The screen is
redrawn to show the part of your drawing that fits within the rectangle.

Dynamic Zoom
Provides an interactive zoom effect using the mouse to control it.
Once the left mouse key is pressed the pointer alters into an enlargement lens. Dragging
the pointer upwards increases the size of the image, while downwards drag reduces it.
The zoom factor may be read in the toolbar display. 

Previous Zoom
Returns to the zoom factor current before the last operation. 

Move
Moves the image by dragging with the mouse. Dynamic interactive preview is given.

Axis View
View (highlight) datum point and X & Y axis vectors.

Distance
Enables the measurement of distance between two points. Left click on first point and
drag pointer to next point, during which time a small text box shows the actual distance.

Stratigraphy legend
This is a switch that activates/deactivates the display of the legends of Stratigraphy.

Discretizzazione
Attiva la visualizzazione della discretizzazione del muro usata dal programma
nell'eseguire i calcoli; i tratti evidenziati con tratteggio rappresentano le sezioni di
verifica.

Note: Zoom does not alter the absolute dimensions of the drawing and does not
impact on its scale when printing.

2.4 Data Menu

Data menu contains items to invoke the windows in which program parameters required
for the calculation may be entered such as wall type, geometric declarations, material
properties, and terrain descriptions.

Main Parameters

Geometry data and loads

Terrain profile

9
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10
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Stratigraphy

Piles

Tiebacks

Materials and Armatures

Carichi sul muro e sul terrapieno

 

 

2.4.1 Main Parameters

This command opens a window in which the main parameters of the project can be
given.

Works description
This field is intended for a synthetic description of the project.

Wall Type
In this pane it is possible to specify the type of wall by selecting from the drop down list
and check boxes.

Global safety margin coefficients
Safety factor coefficients for slide, overturn and limit load can be specified here and can
if required be saved as predefined in other projects.

Thrust
This pane is used to determine a number of factors and methods in the calculation of soil
thrust either at rest (i.e. for fixed head supports) or active.
For Active thrust it is possible to opt either for Rankine's method - valid for horizontal
backfill with no soil/wall friction (d=0), or Mononobe & Okabe' s method - valid for
seismic condition - based on Coulomb's non seismic condition theory. For passive thrust
on downhill terrain the actually applied percentage thrust can be specified. The program
only calculates passive thrust on terrain downhill of the wall footing and not on the soil
covering it (See Fill pane).
In the evaluation of increase in thrust due to seismic action, the user is requested to
specify the point of application of such increment on the stem either at 1/3,or 2/3 of H,
considering seismic thrust diagram as a triangle or as a constant on stem height at 1/2
H.

Foundation
Soil resistance values for slide resistance verification are taken parameters in
stratigraphy data unless these are otherwise specified here.

Seism  

10
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2.4.2 Wall Geometry and Loads

This option opens a tab window in which definition of wall geometry, loads on the wall or
on the backfill can be entered.
This option opens a tab window in which definition of wall geometry, loads on the wall or
on the backfill can be entered. 

Wall Geometry
Wall geometry is entered by wall element. Thus a pane each is devoted to wall stem,
wall footing, footing key, and flying shelf. It is also possible to define the uphill side of
the  wall as a number of steps, whose individual geometry is then declared.
Within the same window, there where no supporting piles are present, a pane enables
the presence of a lean mix base below the footing to be specified, that is taken into
consideration for slide limit state verification.

Loads on backfill
A strip load on the backfill may be modeled, declaring its extent by entering its initial and
final abscissa. Load scale may be used to define the desired scale. Reference point is the
X vertex of the wall head.(see Loads in menù Projects)

Point loads (on the wall)
Vertical and horizontal forces and moments may be applied to the model at any point of
the wall.
These may be declared in tabular form entering ordinal number, X and Y coordinates
referred to the lower corner of the downhill footing, and the load extent.
Horizontal forces are entered as positive numbers when acting right to left, the vertical
when acting top downwards, and moments when acting anticlockwise.(see Loads in
menù Projects)

2.4.3 Terrain profile

This screen enable the terrain profile on either side of the wall to be defined in one
(downhill) or two (uphill) segments of which the first is the one abutting upon the wall
and may be inclined to rise or fall as required. It is further possible to model an
embankment on the uphill side, that rises above the stem head, whose height and
weight per unit volume is declared here.

2.4.4 Stratigraphy

No.: Layer ordinal number.

N.B.: Layers must be entered in sequence from the uppermost down.



Menu 11

© 2009 GeoStru Software

Soil DB: The user can take advantage of a database of more common soils that is
included in the program. To expand the scope of this database refer to  Resource files
from the Introduction.

Height i [cm]: Height of upper level of layer. This will coincide with the lower level
height of the previous layer (if any).

Height f [cm]: Height of lower level of layer. This will coincide with the upper level
height of the next layer (if any).

Incl. [°]: Inclination of layer in respect of the horizontal.

Water Table: Check to indicate that layer is in contact with the water table so as to
consider the thrust effect of water and the analysis of effective pressures. In such a
case, please enter the total weight per unit volume.

K: Layer permeability.

Gamma: Soil weight per unit volume.

Fi [°]: Soil shear resistance angle; where water table is present enter the effective
parameter.

c : Soil cohesion; where water table is present enter the effective parameter.

delta [°]: Soil-wall angle of friction.

Elastic Modulus: Elastic modulus of the layer. This is required to evaluate settlement
where piles are involved.

Colour: Use colour palette to select colour that will denote this layer.

Description: Identifying description of the layer.

Fill: For fills on either side of the wall, it is required that: Soil weight per unit volume,
Shear resistance angle, and Height be given in order to evaluate the stresses on the wall
stem and foundation. The data is entered on a tab card at the right side of the screen.

N.B.  In  the  global  checks  (load  limits,  overturning  and  sliding),  the
thrust  is  referred  to  a  plane  passing  through  the  extrados  of  the
founding  upstream.  Along  this  plane,  the  friction  that  develops  in
the presence of the shelf of founding is soil-soil friction and not soil-
wall. Where, however, the foundation upstream is not present or is
negligible, it is reasonable to assume that throughout the plan is to
develop soil-wall friction, so the thrust evaluated with the theory of
Coulomb  is  inclined  the  angle  friction  d  of  the  soil-wall.  In  such
cases  it  is  possible  to  use  the  angle  of  soil-wall  for  global  checks
selecting  this  option  down  in  the  environment  of  definition  of  the
stratigraphy.



MDC12

© 2009 GeoStru Software

2.4.5 Piles

When a wall resting on piles is specified (Main Parameters) the Pile command is made
available in the Data Menu, within which the pile configuration can be specified.

Pile properties
Type and geometry as well as the coefficient of horizontal reaction, whether this is
constant or varies with depth, and Poisson coefficient for the layer in which the pile tip is
embeded for the calculation of settlement.

Foundation placement
To be able to locate the piles in the model the xxis distance from external edge is
requested. In case of double pile row these are placed symmetrically, in case triple,
threse are place in quincuncial format. Finally the distance of the longitudinal interaxis
distance is requested.

Pile inclination
To each pile can be assigned a positive (anticlockwise) inclination.

Safety coefficients
For the calculation of bearing capacity, it is possible to declare a reduction of the tip and
lateral limit loads by giving specific coefficients or else reduce to total limit load by giving
a total reduction coefficient. See Technical notes regarding Bearing capacity calculation.

Analysis options
For pile calculations, it is possible to choose either overturning moment or total moment
of the action transmitted to the wall structure.

2.4.6 Tiebacks

A tieback is considered by the program as a force of the same magnitude as the drag,
applied to the wall. This force is taken into consideration in the calculation of global
stability whenever any potential slide surface crosses the line of the tieback.

N°
Ordinal tieback no.

DH [cm]
Distance of tieback from wall stem head.

Li [cm]
Length of drag rod/cable of tieback.

La [cm]
Length of anchor part of tieback.

Df [cm]
Perforation diameter.
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Db [cm]
Bulb diameter.

Inter. [cm]
Longitudinal spacing.

Incl. [°]
Angle to horizontal.

Soil-Tieback friction [°]
Soil/Tieback angle of friction

Adhesion
Tieback/Soil adhesion.

No. of Strands
No. of strands in tieback cable.

Tieback drag 
User choice for drag value for tieback that, when entered, overrules that calculated (and
shown here) by the program.

Colour
Select colour that should denote the tieback.

Suggested path to applying tiebacks to wall:

1.Calculate wall without tiebacks.

2.Enter tieback geometry: as data is entered the program automatically calculates the
tieback's drag. The user can override the calculated value by entering the preferred
one.

3.Repeat wall calculation and check the foundation stress diagram. It is desirable that
this diagram result roughly rectangular or at least with the major side on the uphill
side. Further slide safety and overturning safety should verify.

4.If the foundation stress diagram does not satisfy the above requirements, the drag
should be reduced or increased as required.

5.If limit load verification fails, piles should be introduced.

6.The tieback rod(cable) length should be such as to place the anchor bulb outside the
rupture zone identified by the program after tieback insertion.

2.4.7 Materials and Armatures

This window enables wall and pile materials and armatures to be determined and of their
verification parameters.
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Reinforced concrete verification parameters

Standard to apply
For the non Italian user, this will reduce to selection of Eurocodes that will involve that
verification will be performed based on ultimate limit state, subject to declaration of
partial safety factors (below) for cement and steel. 
Verification by the Admissible pressures method is in practice bound with selection of
Italian national standards.

Concrete, partial safety factor
Partial safety factor to determine calculation resistance for concrete. Eurocodes value =
1.5.

Steel bar, partial safety factor
Partial safety factor to determine calculation resistance for reinforcement steel.
Eurocodes value = 1.15.

I parametri di cui sopra sono assunti in automatico dal programma in funzione della
normativa scelta dall'utente.

Ratio between stretched and compressed reinforcement
The ratio between stretched and compressed reinforcement in each section is held to the
value requested by the user.

Distribution steel
Distribution steel quantity is calculated as the user selected percentage of the stretched
reinforcement of the most reinforced section. 

Lap splice bars
There where the reinforcement bars anchored in the footing, do not extend for the full
height of the stem, additional bars extend to the full height these are spliced to the
original ones. The user is requested to specify the anchorage length of the original bars
extending above the footing.

Wall Material

Material properties
For concrete typical cubic resistance value and specific weight are required.
For reinforcement steel the required values are typical yield strength ( Fyk) permissible

tension (for permissible tension verification), the elastic modulus the homogeneity ratio
and the cover value.
Naming conventions for concrete resistance are  dependent on the choice of
measurement units S.I. (International) or M.K.S. (technical). In either case the typical
cubic resistance according to the following convention.

M.K.S. Rck250 Rck300 Rck350

S.I. C-20 C-27 C-30
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Stem bars - Footing bars - Barre dente
For each of these elements it is possible to specify differentiated bar diameter, and
minimum and maximum number of bars.
Based upon these parameters the program attempts verification at various vertical
levels, starting with the minimum and proceeding up to the maximum number of bars,
and if these verifications fail, the diameter is increased until verification succeeds

Pile Material

Material properties
For concrete typical cubic resistance value and specific weight are required.
For reinforcement steel the required values are typical yield strength ( Fyk) permissible

tension (for permissible tension verification), the elastic modulus, the homogeneity ratio,
and the cover value.

Longitudinal bars - Tie bars - Tubular armature
For reinforcement steel the required values are typical yield strength (Fyk) permissible

tension (for permissible tension verification), the elastic modulus, the homogeneity ratio,
and the cover value.
If the pile is also reinforced with tie bars and or longitudinal bars, diameter and number/
separation are requested.
For tubular armature internal and external diameter are requested, however selecting
from a drop down list of types these data are inserted automatically.

2.5 Compute Menu

Computation
Performs geotechnical calculation on the wall and displays summary results.

When invoked the command presents the Combination (see Loads nel menù Projects)
screen where the user defined loads (backfill and wall loads) are shown along with those
calculated by the program (i.e. weight, thrust, seism,  water thrust etc.) 
At this point the user may wish to define a number of combinations of actions and
coefficients to verify the structural resistance of the wall, of the terrain specifying
reductions in property values.
The program itself generates two combinations (see Loads). One for wall structural
capacity and the other for geotechnical dimensions.
The program performs a complete calculation for each combination (i.e. Computation
model ) and returns a summary of the more notable verification results   (overturning,
sliding an bearing capacity). When one of the combinations fails verification in one or
more respects this is highlighted.
Combinations may be removed with the mouse or using the tool bar buttons:

· Cancel combination
Select target combination and press right mouse key then click Cancel
combination to remove it.

1
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· Verify combination
Select target combination and press right mouse key then click Verify.

· New combination
Click right mouse on the text 'Load Combinations' in the entry pane (not the
pane Heading) and click on New.

Layer View
Displays wall  and soil layers.

Discretization
Displays wall segmentation. 

Soil Pressures
Displays diagram of soil pressures on wall.

Water table pressures
Displays diagram of water pressures.

Foundation pressures
Displays progress of pressures on foundation (only if no piles are used).

Moments diagram
Displays diagram of moments on stem and footings.

Static-dynamic wedge
Displays magnitude of thrust wedge.

Armature
Displays armature list. Armature includes all armatures in combinations.

Resultant armature
For the combination selected in the tool bar, the armature involved is displayed.

Armature editor
This function opens the armature editor where in amendments to the armature can be
made.

Global stability analysis
This function invokes the process of global stability analysis.

Materials Estimate
Displays  the estimate of quantities of steel and concrete required.

2.6 Export Menu

Enables selection of export format for the calculation results.

26
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Generate RTF Report
Generates the computation report in an Internal editor (RTF Editor from the
Introduction) window. This provides its own File menu with Print and Save functions. 

Export in DXF format
Stores in DXF format the contents of the worksheet window. 

Export in Bitmap format
Stores in BMP format the contents of the worksheet window. 

Note: Exported file have the same name as the project with unique suffix and
the type (DXF, BMP, RTF). 

2.7 Preferences  Menu

Options
Opens the Options window in which the following may be determined:

Worksheet

Colours
Line & background colours.

Graphic
Line thickness.

Outputs

DXF Parameters
DXF file export folder path text size & scale factor.

Text Output
RTF report margins, background colour, & table formatting.

Company data
Enable the recording of four lines of company data as Headings in reports.

Save
Enable selection of and interval for automatic project file saving.

International System (S.I.)
Switch to select International System (S.I.) (See Measurement Units ).

M.K.S. System
Switch to select M.K.S. System (S.I.) (See Measurement Units ).

Language Selection
Opens a window to enable an alternative language to be set. After an alteration, closing
the window initiates the program closing sequence. On restart the new language is

2

2
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operative.

2.8 Help Menu

Help
Opens Help window.

Registration
Opens Registration window. Within this window the Registration number obtained from
Geostru can be recorded.

About
Shows window with program version and revision numbers.

2.8.1 Registration

The program is distributed both on CD, or as a download, in a demonstration mode
In Demo mode, some functions, among which, print, export and save are suppressed,
and assignment of point coordinates is randomly altered while the other functions remain
active, thus demonstrating its capabilities.
When the user purchases the program the registration number necessary for full
functionality may be obtained by sending GeoStru Software S.a.S. the Control Number
to be found in the registration window.
GeoStru Software S.a.S. will respond with the correct registration number. 
This may then be entered (one time operation) into the registration window field. The
whole exchange may occur by Email quoting the license number. The registration
number is specific to the computer and if the program is to be loaded on another PC, a
new registration number should be requested, giving the control number, which appears
on that machine.
An alternative to this process is to obtain a hardware lock (dongle) which when inserted
in the parallel or USB port opens all the functions of the program. This must however be
present whenever the program should be used.

3 Projects

3.1 Data Input

A suggested approach, until better familiarity with the program is reached, is to generate
a default wall design by selecting "New Project Step by Step" in the File Menu. This
design can then be amended to reflect user requirements.
The default sizing of the wall is conditioned by the support height declared and the
geotechnical terrain parameters.
Wall Geometry and Loads (from the data menu) functions can be used to alter the



Projects 19

© 2009 GeoStru Software

default sizings as required, while the geotechnical parameters can be specified in
Stratifigraphy, both to be found in the Data menu.

3.2 Materials and Armatures

This window enables wall and pile materials and armatures to be determined and of their
verification parameters.

Reinforced concrete verification parameters

Standard to apply
For the non Italian user, this will reduce to selection of Eurocodes that will involve that
verification will be performed based on ultimate limit state, subject to declaration of
partial safety factors (below) for cement and steel. 
Verification by the Admissible pressures method is in practice bound with selection of
Italian national standards.

Concrete, partial safety factor
Partial safety factor to determine calculation resistance for concrete. Eurocodes value =
1.5.

Steel bar, partial safety factor
Partial safety factor to determine calculation resistance for reinforcement steel.
Eurocodes value = 1.15.

I parametri di cui sopra sono assunti in automatico dal programma in funzione della
normativa scelta dall'utente.

Ratio between stretched and compressed reinforcement
The ratio between stretched and compressed reinforcement in each section is held to the
value requested by the user.

Distribution steel
Distribution steel quantity is calculated as the user selected percentage of the stretched
reinforcement of the most reinforced section. 

Lap splice bars
There where the reinforcement bars anchored in the footing, do not extend for the full
height of the stem, additional bars extend to the full height these are spliced to the
original ones. The user is requested to specify the anchorage length of the original bars
extending above the footing.

Wall Material

Material properties
For concrete typical cubic resistance value and specific weight are required.
For reinforcement steel the required values are typical yield strength ( Fyk) permissible

tension (for permissible tension verification), the elastic modulus the homogeneity ratio
and the cover value.
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Naming conventions for concrete resistance are  dependent on the choice of
measurement units S.I. (International) or M.K.S. (technical). In either case the typical
cubic resistance according to the following convention.

M.K.S. Rck250 Rck300 Rck350

S.I. C-20 C-27 C-30

 

Stem bars - Footing bars - Barre dente
For each of these elements it is possible to specify differentiated bar diameter, and
minimum and maximum number of bars.
Based upon these parameters the program attempts verification at various vertical
levels, starting with the minimum and proceeding up to the maximum number of bars,
and if these verifications fail, the diameter is increased until verification succeeds

Pile Material

Material properties
For concrete typical cubic resistance value and specific weight are required.
For reinforcement steel the required values are typical yield strength ( Fyk) permissible

tension (for permissible tension verification), the elastic modulus, the homogeneity ratio,
and the cover value.

Longitudinal bars - Tie bars - Tubular armature
For reinforcement steel the required values are typical yield strength (Fyk) permissible

tension (for permissible tension verification), the elastic modulus, the homogeneity ratio,
and the cover value.
If the pile is also reinforced with tie bars and or longitudinal bars, diameter and number/
separation are requested.
For tubular armature internal and external diameter are requested, however selecting
from a drop down list of types these data are inserted automatically.

3.3 Seism

Calculation of seismic movement effects is dependent on a number of parameters, that
in turn are dictated or recommended by various legislative norms. This program, with
Italy as country of origin includes norms native to that country as well as the Europe
wide Eurocodes 8.
This latter is the more relevant for users outside Italy and will be treated here. If it is
desired to consult the Italian standards, the user is referred to the Italian language help
file, accessible directly by executing the file: Muri_IT.chm in the home folder for the
program.
The following parameters can/should be entered or considered by the user.

Soil Category
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Type A soils Stone like formations or very rigid homogeneous soils S=1

Type B soils
deposits of highly condensed sands or gravels or highly
consistent clays

S=1.25

Type C soils
deposits of moderately condensed sands or gravels or
medium consistent clays

S=1.25

Type D soils
deposits of granular, loose or slightly dense soils, or else
cohesive soils of slight to medium consistency

S=1.35

Project seismic acceleration

· No seism Zone

· Zone 1 = 0.35g

· Zone 2 = 0.25g

· Zone 3 = 0.15g

· Zone 4 = 0.05g

 Factor r
The recommendation for reinforced concrete walls factor r is a value of 1. Only for
gravity walls or such as are deformable can this set to 2.
The factor is used in the determination of horizontal seismic coefficient.

Horizontal seismic coefficient Kh

See Theoretical notes. Used in evaluating project force in seismic condition.

Vertical seismic coefficient  Kv

See Theoretical notes. Used in evaluating project force in seismic condition with sign +
or – depending on a more unfavourable effect.

3.4 Tiebacks

A tieback is considered by the program as a force of the same magnitude as the drag,
applied to the wall. This force is taken into consideration in the calculation of global
stability whenever any potential slide surface crosses the line of the tieback.

N°
Ordinal tieback no.
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DH [cm]
Distance of tieback from wall stem head.

Li [cm]
Length of drag rod/cable of tieback.

La [cm]
Length of anchor part of tieback.

Df [cm]
Perforation diameter.

Db [cm]
Bulb diameter.

Inter. [cm]
Longitudinal spacing.

Incl. [°]
Angle to horizontal.

Soil-Tieback friction [°]
Soil/Tieback angle of friction

Adhesion
Tieback/Soil adhesion.

No. of Strands
No. of strands in tieback cable.

Tieback drag 
User choice for drag value for tieback that, when entered, overrules that calculated (and
shown here) by the program.

Colour
Select colour that should denote the tieback.

Suggested path to applying tiebacks to wall:

1.Calculate wall without tiebacks.

2.Enter tieback geometry: as data is entered the program automatically calculates the
tieback's drag. The user can override the calculated value by entering the preferred
one.

3.Repeat wall calculation and check the foundation stress diagram. It is desirable that
this diagram result roughly rectangular or at least with the major side on the uphill
side. Further slide safety and overturning safety should verify.

4.If the foundation stress diagram does not satisfy the above requirements, the drag
should be reduced or increased as required.



Projects 23

© 2009 GeoStru Software

5.If limit load verification fails, piles should be introduced.

6.The tieback rod(cable) length should be such as to place the anchor bulb outside the
rupture zone identified by the program after tieback insertion.

3.5 Loads

Loads may be modeled on the project as:

1.  Loads distributed on backfill;

2.  Loads on the wall structure.

Loads may be specified either by acting on the respective tool bar icon or by invoking
"Wall Geometry and loads" from the Data Menu. 

Distributed loads
The extent of the load is defined by the start and end abscissa values; the load value can
be constant or variable. The depth indicates its placement in relation to the stem head. 
Even multiple loads can be defined and their action combined during the calculation
according to specified permutation factors.
The effect of loads on the active thrust is only considered if this is located within the
failure wedge. 

Point loads
Such loads can be modeled according to the following conventions below: 

· Horizontal forces (Fx) defined as a positive value when directed right to left;

· Vertical forces (Fy) defined as a positive value when directed top downwards;

· Moments (Mz) positive when anticlockwise.

Multiple point loads can also be defined and their action combined during the calculation
according to specified permutation factors.

Load permutations 
The user can define that loads be considered in calculation, in one or more combinations
each with specific coefficients. 
Computation  from the menu with the same name brings up a “Combination” dialog
window from within which, new combinations can be defined and calculation performed
for each of them.
By default, the program suggests (For Eurocodes) two load combinations:

· The first (A1 + M1) aimed at determining the structural capacity of the wall, uses
actions amplified by specific coefficients (A1), shown below, and the given
geotechnical parameters (M1);

· The second (A2 + M2), aimed at geotechnical sizing of the structure, uses actions
as defined (A2) and reduces the defined geotechnical values by specific
coefficients (M2).

15
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Resistance parameter
Specific coefficient gm

M1 M2

Shear resistance angle

tangent: tanj
'
k

1,00 1,25

Effective cohesion c
’
k 1,00 1,25

Undrained cohesion cuk 1,00 1,40

Unit volume weight g 1,00 1,00

 

Action
Specific coefficient 

A1 A2

Constant
unfavourable

1,40 1,00

Constant
favourable

1,00 1,00

Variable
unfavourable 

1,50 1,30

Variable
favourable

0,00 0,00

These defaults may be varied by the user by selecting the relevant one and altering the
specific coefficients.

New combinations
New combinations may be added (check the new combination button or right click on

the ‘Combinations’ column header).

This displays the all calculated loads (structure weight, soil weight, thrust, seism) and

those defined by the user (Distributed and point loads) as well as resistance parameters

(Shear resistance angle, cohesion etc.) all with specific factors set at one which the user

can change to reflect requirements. 

Delete combination
Combinations can be deleted either by right click on the combination name in the list or
by selecting and pressing the delete button. 

Rename combination
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The name of combinations are assigned when inserted and can be altered at any time by
selecting it on the list and typing the new name in the list box (top right). 

Verify combination
The user may run a verification of all combinations by pressing the computation button.
The program shows with a yellow triangle those that totally or partially failed to verify
(Overturn, slide and limit weight verification). By clicking on the combination name on
the list the results of that combination are shown in the relevant boxes. 

3.6 Compute progression

Calculation progresses through a number of steps.

Step 1
The wall stem is divided into a number of sections. For each section the thrust
coefficients (Ka, Ko, Ks)  are evaluated as also the proportions of each coefficient
absorbed by the vertical and horizontal thrust components so that for each section these
components are evaluated and the incidence point determined.
Thereafter for each section the weight of the wall, its centre of gravity coordinates, and
its inertial force are determined.
Then when all forces acting on the stem are determined, the program calculates the
tensions on each section (Fx = Shear; Fy = normal tension; M = Moment) and then the
calculates of the armatures.

Step 2
In this step the sequences in step 1 are repeated but in respect the total wall height (i.e.
stem and footing) and thrust calculation is related to a vertical line that passes through
the uphill edge of the foundation heel. 
The analysis in this step yields global forces, and those at every section that will be used
for verification of overturning, sliding, and limit load.
For cantilever walls, in this step footing thrust and the contribution to the passive thrust
generated downhill are calculated. In the report will be found the total forces taken into
account in global verification.

Step 3
In the last step having ascertained soil pressures, normal shear and moment forces on
the joints of the toe and heel base sections to the stem are calculated. Thereafter
armatures for these sections are calculated.
Wall anchored on piles.

Where pile further support the footing
In  Step 2 , overturning and resulting moments are calculated (Mstab- Mrib) in respect of
the lower corner of the toe base. These are transmitted to the piles, according to
previous user choice and the components absorbed by each pile, differentiated between
compression and extension, are calculated.
The forces acting on the most affected pile are used to calculate stem head
displacement, settlement and soil horizontal limit pressure corresponding to the
wavelength.
The program calculates peak lateral and total limit load of foundation soil and proceeds
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to verification of the sections of the pile subject to greatest tension and returns normal
force, moment and armature of the section.
In Step 3 in the verification of the up and downhill footing bases, the reactions of piles
on these are applied  and thereafter the process is as described.

3.7 Armature Editor

Within Armature Editor the user can modify and verify wall armatures.

Bar selection
Amendment of the single bar requires that it be selected and this is achieved by utilising
the Select command icon in the side pane and clicking on the target bar within the wall
diagram. On selection, the ends of the bar are highlighted by small coloured spots at
every vertex. The characteristics of the bar (number, diameter, length and inclination)
are shown on the Armature Editor pane and may be altered there.
If a bar is selected  from the explosion bar diagram beside the wall, as opposed to within
it, it can only be moved.

Freeze and unfreeze a bar
As a safety measure it is possible to 'freeze' a bar, that is to prevent any alteration to it.
This function is available from a floating menu recalled by right clicking the mouse. On
the same menu an unfreeze all releases all bars to editing.

Bar alterations
Each bar can be cut, shaped, by introducing one or more vertices, or removed.
Commands for these operations are within the floating menu invoked by right clicking
within the worksheet area and must be confirmed by the Apply command. Once removed
a bar cannot be reinserted and in such cases the undo edits command should be used.

Armature Verification
After having altered the armature the alterations should be verified. Selecting the 
Armature list command (or pane tab), opens the Armature specification list showing
value before editing. Pressing the Bar compute values button updates the list with the
alterations.
At this point the Verify button performs verification of the armature and unless a
message appears this can be taken as satisfactory. The amended armature is included in
the Calculation Report.
Please note that on the wall stem, the diameter of reinforcement bars on the
same side, up or down hill, must be the same.

3.8 Global Stability

This performs Global Stability verification with the classical DEM and Limit Equilibrium
methods. Verification can be performed both with circular and free form slip surfaces. For
circular surfaces, the program generated a default centres grid however the user can
alter it and move it as required. 
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3.9 Customize

Graphic profile of projects can be customized either in the Preferences menu or in the 
Options tab of the Data card placed on the right of the worksheet.
Both font type an size and colours of the various components can be determined.

3.10 Gravity Wall

For Gravity walls, the program reports the results of thrust calculation and verifies slide,
overturning, and limit load. Moreover it performs verification of cohesion of stem to
footing joint. The latter is performed to check that the section under consideration does
not generate traction but only compression tension. Such verification is presented in the
report.

3.11 Fixed Head Wall

For for fixed head wall calculation, it is advisable to select thrust at rest (Ko) and to
apply a low value for passive thrust contribution (min. 1%). The program reports soil
pressure, that will have a nearly constant value.
Such walls are considered fixed in downwards and downhill directions.
For this type of wall, stem head movement is inhibited, so that the program only
performs verification of limit load of foundation on its base, and omits slide and
overturning verification.

4 Seismic coefficients

The values of the horizontal and vertical seismic coefficients can be manually assigned
by the user.
They can also be calculated automatically by the software on the base of the maximum
acceleration at site.

For the application of Eurocode 8 (geotechnical planning), the horizontal
seismic coefficient is defined as follows:

hv

IgR

h

KK

g
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K

×±=

××
=

5.0
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where:

agR: reference peak acceleration on hard outcropping ground,
gI: importance factor,
S: soil factor, depending on the kind of ground (from A to E). 

is the “design ground acceleration on type A ground”.

5 Theoretical Notes

5.1 Standards

The Standards that can be chosen for geotechnic and structural calculation are 
European Union Eurocodes and also specific Italian National legislation norms as
listed below, that may be of relative interest to the non Italian user.

Eurocode 2
Projects involving concrete structures. Part 1-1: General Rules.

Eurocode 7
Geotechnic Projects. Part 1: General Rules.

Eurocode 8
Project guidelines for structural resistance to seismic events. Part 5: Foundations,
Retaining structures, and geotechnical aspects.

Italian National legislation:
(quoted from relevant legislation)

NTC 2008
Ministero delle Infrastrutture e Trasporti Norme Tecniche per le Costruzioni marzo

2005. 
Ordinanza della Presidenza del Consiglio dei Ministri  n. 3274 del 20 marzo
2003 e successive modifiche ed integrazioni:

· Primi elementi in materia di criteri generali per la classificazione sismica del
territorio nazionale e di normative tecniche per le costruzioni in zona sismica.

· Allegato 2 – Norme tecniche per il progetto, la valutazione e l’adeguamento
sismico degli edifici.

· Allegato 4 – Norme tecniche per il progetto sismico di opere di fondazione e di
sostegno dei terreni.

 
D.M. 11 Marzo 1988
" Norme tecniche riguardanti le indagini sui terreni e sulle rocce, la stabilità dei
pendii naturali e delle scarpate, i criteri generali e le prescrizioni per la
progettazione e il collaudo delle opere di sostegno delle terre e delle opere di
fondazione".
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D.M. 9 Gennaio 1996
"Norme tecniche per il calcolo, l'esecuzione ed il collaudo delle strutture in cemento
armato, normale e precompresso e per le strutture metalliche".
 
D.M. 16 Gennaio 1996
"Norme tecniche per le costruzioni in zone sismiche".

STAS 3300-10107/0-90

5.2 Active earth pressure

Active thrust calculation using Coulumb's method is based on global limit
equilibrium theory of a system whose components are the wall and the wedge of
homogeneous terrain behind the work assuming rough surface.
Where terrain is dry and homogeneous the pressure diagram is expressed linearly by the
following 

 
Pt = Ka ´ gt ´ z

 
Thrust St is applied at 1/3 H with the value

 

 
 

Having :
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Limit value of KA:

d < (b-f-e)  according to Muller-Breslau
 
 

gt = Terrain unit volume weight

b = Inside wall surface inclination to horizontal plane of footing;

f = Terrain shear resistance angle;

d = Angle of friction terrain to wall.

e = Field level inclination to horizontal - Positive if anticlockwise;

H = Wall height.
 

 

Active thrust calculation according to Rankine  

If e = d = 0 e b = 90° (wall with smooth surface and backfill with horizontal surface)
thrust St is simplified to:

 

(tg=tan)
 

that coincides with Rankine's equation that gives active thrust where backfill is
horizontal.
Effectively Rankine used the same hypothesis as Coulumb except that he ignored wall-
terrain friction and cohesion. Rankine's expression for Ka in general form is as follows:

 

 
 

Active thrust calculation according to Mononobe & Okabe  

Mononobe & Okabe's evaluation of active thrust concerns thrust in seismic states with
pseudo static method. This is based on global limit equilibrium theory of a system whose
components are the wall and the wedge of homogeneous terrain behind the work in an
artificial configuration in which  both field level inclination and the angle b - inclination of
internal wall surface to horizontal -are increased by an amount q such that:
 

tg q = kh/(1±kv)

 
where  kh is the horizontal seismic coefficient and kv the vertical.

Where no specific studies exist coefficients kh & kv should be calculated as:

 
kh = S×ag/r                  kv = 0,5 kh

 
where  S×ag is the maximum seismic acceleration in the various categories in the
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stratigraphic profile.
Factor r can take the value 2 where the work is one of some flexibility (e. g. gravity
walls). In all other  cases (Stiff concrete walls, On piles, Fixed head)) it should be set to
1.

 
Effect due to cohesion 
Cohesion introduces negative constant pressures as:

 
 

 
As it is not possible to calculate a priori the thrust reduction caused by cohesion a
critical height  Zc has been calculated as:

where:

Q = Loads acting on the backfill.
 
If Zc<0 the effect may be applied directly as a decrease whose value is:

 

Sc = Pc× H
 

applied at  H/2.
 

 
Uniform load on backfill
A load Q, uniformly distributed on the backfill generates constant pressures as:

 

Pq = KA´Q´senb/sen(b+e)

Integrating, a thrust Sq:

 

 
 

Applies at  H/2, indicating as Ka  the Muller-Breslau active thrust coefficient.

 
Active thrust in seismic state
In seimic state the calculation force exercised by the backfill on the wall is given by:
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where:

H = wall height
kv = vertical seimic coefficient

g = terrain unit volume weight

K =  total thrust coefficient (static + dynamic)
Ews = hydrostatic water thrust

Ewd = hydrodynamic thrust

 
For impermeable terrains, hydrodynamic thrust Ewd = 0, but a correction on

evaluation of the angle q in Mononobe & Okabe's formula is made as follows:

 
In highly permeable terrain in seismic states, the same correction is applied but
hydrodynamic thrust assumes the following value:

where H' is the height of the groundwater tables(Gwt) from the base of the wall.
 

Hydrostatic thrust
Gwt whose surfac is at height Hw from the base of the wall generates hydrostatic

pressures normal to its surface that at depth z are expressed as:
 

Pw(z) = gw ´ z   

 
Resulting as:

Sw = 1/2 ´ gw´ H²

Thrust of submeged terrain can be obtained substituting  gt by  g't(g't = gsaturo - gw),

effective weight of submerged material. 
 

Passive resistance
In homogeneous terrain a linear diagram of pressures results:

 

Pt = Kp´ gt´ z

 
integrating with passive thrust:

 

 
having:
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(Muller-Breslau) with d  limit values at:

d< b-f-e
 

The expression for  Kp according to Rankine assumes the following form:

 

5.3 Soil limit load

Brich - Hansen (EC 7 – EC 8)

In order that a foundation may safely sustain the projected load in regard to general
rupture for all combinations of load relative to the ultimate limit state, the following must
be satisfied: 

where:
Vd is the project load at ultimate limit state normal to the footing, including the

weight of the foundation itself; 
Rd is the projected foundation ultimate limit load for normal loads, also taking into

account eccentric and inclined loads. When estimating Rd for fine grained soils
short and long term situations should be considered.

Limit load in drained conditions is calculated by:

where:

Project effective foundation
area. There where eccentric
loads are involved, use the
reduced area at whose center
the load is applied.

cu Undrained cohesion.
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q Total lithostatic pressure on
footing.

sc Foundation shape factor.

Rectangular shapes.

Square or circular shapes.

Correction factor for
inclination of load H.

Project limit load in drained conditions is calculated as follows: 

where:

Form factors

Rectangular shape

Square or circular shape
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Rectangular shape

Square or circular shape

Rectangular, square, or
circular shape

Resultant inclination factors due to an horizontal load, H  parallel to L'

Resultant inclination factors due to an horizontal load, H  parallel to  B'

 
Beside the factors enumerated above, the following are also taken into account: 
Complementary of footing depth. of footing inclination and of field level inclination (
Hansen). 

5.4 Pile limit load

Sign convention

1. Vertical force Fy' is positive when directed downwards;

2.  Horizontal force Fx is positive when directed towards the right;

3.  Couple M is positive when acting to produce movements such as those produced by
horizontal force Fx.

 

Winkler model analysis of pile in operating status

Winkler's model enables variations in mechanical properties of terrain and layers to be
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taken into consideration simply.
Where material is homogeneous (K constant) Hetènyi's classification is adopted that
defines three different pile behaviour for Winkler depending on relative terrain rigidity (l)
soil/pile that is: short or rigid pile, relatively flexible pile, infinitely flexible pile.

Limit vertical load

Limit vertical load is calculated with static formulas that express it in function of pile
geometry, of terrain properties and of the interface pile soil.
For the purposes of calculation limit load  Qlim is conventionally apportioned in two parts:

tip resistance  Qp and lateral resistance Qs.

 

Tip resistance

Tip resistance  qp where the terrain displays friction (j) e cohesion (c), is give by:

 

qp = c ´ Nc + g ´ D ´ Nq

 
where:

g  = Terrain unit volume weight

D = Pile length;
Nc & Nq= Bearing capacity factors including form factor (circular).

 
Factor Nq is calculated according to  Berezantzev.

 

Stem resistance

Lateral bearing capacity is calculated using method A proposed by Tomlinson
(1971) according to the following: 

fs = A´c + q´K´tg d

 
c = Average cohesion value (or shear resistance in undrained conditions).
q = Effective vertical pressure of the terrain.
k = Coefficient of horizontal thrust. This depends on the technique of the pile and
on the previous compaction state and is calculated as:

 
For driven piles K = 1 + tg2f
For drilled piles K = 1 - tg2f
 

d = Pile/soil friction coefficient as function of pile surface.

 
For driven piles d = 3/4´tg f
For drilled piles d = tg f
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a is a coefficient as below:
 

Driven pile coefficient
 

c < 0.25       a = 1.00

0.25 < c < 0.5 a = 0.85

0.5 < c < 0.75 a = 0.65

0.75 < c <2.4  a = 0.50

c  >2.4 a = 1.2 / c

 
Drilled pile coefficient

 
c < 0.25  a = 0.9

0.25 < c < 0.5   a = 0.8

0.5 < c < 0.75 a = 0.6

0.75 < c < 2 a = 0.4

c  > 2   a = 0.8 / c

  
Further according to Okamoto guidelines where seismic state occurs lateral resistance ie
reduced depending on the seismic coefficient kh  as follows:

 
Coeffrid = 1 - kh

 
Finally:

1.  For driven piles both resistance properties (c, j) and the coefficient of the terrain
horizontal modulus are reduced by 10%.

2.Where drag action is encountered, tip load is null and lateral load is reduced by 70%.

3.In the vertical safety margin the weight of the pile has been taken into account.
 
 

Settlements

Vertical settlements are calculated using the Davis-Poulos method, according to which
the pile is considered as rigid (undeformable) embedded in an elastic medium, semi
space, or layer of finite thickness.
The hypothesis considers that the interaction between pile and soil is constant for each
(n) cylindrical segments in which the pile side surface is subdivided.
The settlement of the i th surface due to the load transmitted by the pile to the soil along
the j th surface may be expressed as:

 Wi,j = (tj / E ) ´ B ´Ii,j
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where:

tj = Increment in tension at the mid point of the segment;

E = Elastic modulus of the terrain;
B = Diameter of the pile;
Ii,j= Influence coefficient.

 
Total settlement is obtained by the sum of  Wi,j for all j areas.

5.5 Global Stability

Global stability determines the safety factor of the joint wall, backfill complex, in regard
to slide along possible failure surfaces.
The safety factor according to the ordinary strip method may be expressed by:

 
 

 
 
 where:

W = typical slice weight;
Q = distributed load;
F = point load;

Ks ´ W = inertial force;

Ks = Seismic intensity coefficient;

l = length of typical slice base;

a = slice base angle to horizontal;
c = terrain cohesion;
f = terrain shear resistance angle;
ro = radius of typical slip surface;

u = gwt generated pressure;
Fo= tieback horizontal load generated by tiebacks;

et = anchorage force eccentricity in respect of centre of rotation;

es = seismic forces eccentricity in respect of centre of rotation.

6 Contact

GeoStru Software
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Lungomare snc, 89032 - Bianco (RC) - Italy
Tel. +39 0964911624  Fax. +39 0964992341

Skype Nick: geostru_support_it-eng-spa

Web: www.geostru.com
E-mail: geostru@geostru.com 

http://www.geostru.com
mailto:geostru@geostru.com
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